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Introduction

This white paper introduces the Broadcom NetXtreme Gigabit Ethernet Plus network adapter.

The Broadcom NetXtreme Gigabit Ethernet Plus is the successor to the Broadcom NetXtreme Gigabit
Ethernet network adapter. In addition to the standard network adapter functionality, the Broadcom NetX-
treme Gigabit Ethernet Plus also features desktop and mobile Architecture for System Hardware (DASH)
support.

More details on DASH and manageability in the Manageability white paper located at www.hp.com.

Product Description

The Broadcom NetXtreme Gigabit Ethernet Plus network adapter is a Broadcom BCM 5761 10/100/
1000Base-T network controller with integrated transceiver, advanced security, and platform management
capabilities including DASH support.

The adapter is a PCle x1 card designed in accordance to the PCle v1.1 specification.

The card comes with a high profile bracket, but is also compatible with low profile brackets. A low profile
bracket is available for this card.

Figure 1 Broadcom NetXireme Gigabit Ethernet Plus Network Adapter
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Feature List

* Integrated 10/100/1000BASE-T transceivers

*  Automatic MDI crossover function

® PCl Express v1.1 host interface with multi-function support

* 10/100/1000BASE-T full/half-duplex MAC

* IPv4 and IPv6 Large Send Offload and Checksum Offload (LSO/TCO)

® Receive Side Scaling (RSS) for multicore client processors

*  Wake on LAN (WOL) support meeting the ACPI requirements

®  Statistics for SNMP MIB II, Ethernet-like MIB, and Ethernet MIB (802.3z, Clause 30)

* System Management Bus (SMBus) interface supporting Desktop and mobile Architecture for System
Hardware (DASH) or Alert Standard Format (ASF) v2.0

* Centralized Power Management Unit (CPMU)

*  Serial NVRAM interface with Flash auto-sensing

® PCle CLKREQ support

* DASH 1.0 and 1.1 support with additional HP value-add management features

USB Cable and Headers

The Broadcom NetXtreme Gigabit Ethernet Plus comes with a double female-ended 10-pin USB cable.
One end of this cable connects to the male USB header on the Broadcom NetXtreme Gigabit Ethernet
Plus, and the other end connects to an identical header on the system board.

The male USB header on the system board is reserved for two functions:
® ReadyBoost
* DASH

DASH and ReadyBoost are mutually exclusive. There is only one USB header for two functions so users
must decide which module to install.

Although there is a similar male USB header on the system board reserved for the Media Card Reader,
this header is not the same as the one for ReadyBoost. DASH will not function in this USB header.

The USB cable serves two purposes and is critical for DASH functionality:
*  Communication between the Management Controller and system BIOS

® Data transfer for USB-redirection

DASH functionality is controlled through the Management Controller (MC) in the BCM 5761 ASIC. Com-
munication between the MC and system BIOS is possible through the ReadyBoost USB header and the
USB cable, because pin 10 is dedicated for SMI generation.
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USB-redirection is a DASH 1.1 feature that allows the contents of a USB device to be directed over a net-
work connection to another system. The data transferred over the network can be transmitted or received
through the USB cable. This feature will be offered on supported systems in a future update.

Supported Platforms

The Broadcom NetXtreme Gigabit Ethernet Plus is available for the following 2008 platforms:
* HP Compaq dc5850 Business PC

*  HP Compaq dc5800 Business PC

* HP Compaq dc7800 Business PC

* HP Compaq dc7900 Business PC

Although the Broadcom NetXireme Gigabit Ethernet Plus is offered for the above platforms, management
functionality is not available for all systems. See the following chart for network and management capa-
bilities.

Platform Network and Management Capability
Standard NIC ASF DASH

HP Compaq dc5850 Business PC X X X

HP Compaq dc5800 Business PC X X

HP Compagq dc7800 Business PC X

HP Compagq dc7900 Business PC X X X

If the Broadcom NetXtreme Gigabit Ethernet Plus is installed in the dc5800, the adapter will automatically
become the primary management target for system BIOS ASF functions.

BIOS Requirements

Update the system BIOS to at least the versions listed below to get the best performance and functionality
from the Broadcom NetXtreme Gigabit Ethernet Plus.

System BIOS Family Revision
HP Compaq dc5850 Business PC 786F6 2.06
HP Compagq dc5800 Business PC 786F2 1.53
HP Compaq dc7800 Business PC 786F1 2.04
HP Compaq dc7900 Business PC 786G 1.08
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Selecting a Management Controller

For the dc5850 and 7900, the on-board network adapter is by default the primary management control-
ler. For systems supporting the full management capabilities, the user will have to manually set the Broad-
com NetXireme Gigabit Ethernet Plus as the primary management controller in F10 Setup for it to control
DASH manageability. Multiple network adapters can function simultaneously, but only one Management
Controller can be active at a given time.

The primary Management Controller can be set through: F10 Setup > Advanced > Manageability
Devices.

F10 Setup Differences

The F10 Setup screens relating to the Management Devices and modes differ slightly between the HP
Compagq dc5850 and 7900 Business PCs.

F10 Setup - HP Compaqg dc5850 Business PC

The current Management Controller: F10 Setup > Advanced > Manageability Devices.
By default, the embedded Broadcom Ethernet controller is primary management controller.

The Broadcom NetXtreme Gigabit Ethernet Plus needs to be changed to primary management controller
for DASH to be enabled.

Figure 2 Management Devices in the HP Compaq dc5850 Business PC

Advanced

Pouer—On Options

Execute Memory Test

BIOS Power-On
Management Devices

Broadcom Ethernet controller PPrimary
Broadcom Ethernet embedded Non—boot

F10=Accept, ESC=Cancel
Bus Options
Device Options

<F1=Help> REMOTE: F1=ESC+1, F5=ESC+5, F10=ESC+0
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The current Management Mode: F10 Setup > File > System Information.

Once the Broadcom NetXtreme Gigabit Ethernet Plus is made, the primary management controller and
the system is rebooted, the Management Mode will change to DASH.

Figure 3 Management Mode (DASH highlighted) in the HP Compaq dc5850 Business PC
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System Information

Product Name

SKU Number

Processor Type
Processor Speed
Processor Stepping
Cache Size (L1/L2/L3)
Memory Size

Memory controller O
Hemory controller 1
Integrated NMAC

System BIDS

Chassis Serial Number
Asset Tracking Number
Hanagement Mode

AMD Phenom(tm) 9600 Quad-Core Processor
2300/1800 MHz
00100F22
12BKBx4 / 512KBx4 / 204BKBx1
4096 MB DDRZ2/800 MHz
DIMM1 1024 NB / DINM3 1024 NB
DIMMZ 1024 MB / DINMM4 1024 NMB
001D92731EC3
786F6 v02.04
HNDS001370
ECHD is off
DASH

Press any key to continue

LOCAL: <Fl=Help> REMOTE: F1=ESC+1, F5=ESC+5, F10=ESC+0

F10 Setup - HP Compaq dc7900 Business PC

The current Management Controller: F10 Setup > Advanced > Manageability Devices.
By default, the embedded Intel Ethernet controller is primary management controller.

The Broadcom NetXtreme Gigabit Ethernet Plus needs to be changed to primary management controller
for DASH to be enabled.
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Figure 4 Management Controller in the HP Compag dc7900 Business PC
lett-Pa
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Intel Ethernet embedded
Broadcom Ethernet controller

Management Devices

Hanagement Operations

: <F1=Help> REMOTE: F1=ESC+1, F5=ESC+5, F10=ESC+0

The current Management Mode: F10 Setup > File > System Information.

The HP Compaq dc7900 Business PC is an Intel Q45-based system which has an integrated Manage-
ment Engine (ME) within the GMCH for management control.

The ME firmware version is displayed in the F10 Setup System Information page right above the Manage-
ment Mode. The placement of the ME firmware version and the Management Mode s in close proximity,
but there is no correlation between the two lines.

The following chart shows the correlation between the Management Controller and Management Mode
for the HP Compaq dc7900.

Primary Management Controller Management Module
Intel ME AMT, ASF, None
Broadcom MC DASH, ASF

In the case of ASF, both management controllers can be in this mode. However, only one of them will
actually be in control.
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Product Name

SKU Number
Processor Type
Processor Speed
Processor Stepping
Cache Size (L1/L2)
Hemory Size
Channel A
Channel B
Integrated MAC

Figure 5 Management Mode (DASH highlighted) in the HP Compaq dc7900 Business PC
Heulett-Packard Setup Utility

System Information
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3000/1333 MHz
00010677 ©OO0OAO7
64KBxZ / 6144KBx1
20648 NB DDRZ/868 MHz/Dual Channel
XMl 1624 NB / X2 e MB
X3 1624 NB 7 X4 6 HB
00215AS5FC41C

78661 vo1.68
abcd123456

System BIOS

Chassis Serial Number
Asset Tracking Humber
HE Firmuare Uersion 5.6.1.1111
Hanagement Mode DASH

REMOTE: F1=ESC+1, F5=ESC+5, F10=ESC-0

Limitations

The Broadcom NetXireme Gigabit Ethernet Plus functions very similarly between a dc7900 and a
dc5850. However, there is one important difference iregarding remote wake and Power-On Password
behavior.

A remote shutdown info a sleep state, S3 - S5, and subsequent remote wake of the dc5850 will bypass
the Power-On Password as the system resumes from the sleep state. This is the expected behavior.

In the case of the dc7900, there is a hardware limitation that does not report the remote wake and wakes
the system as a localized wake. Therefore, the BIOS reacts to the wake event as a localized wake and
does not bypass the Power-On Password.

Drivers
The Broadcom NetXtreme Gigabit Ethernet Plus has driver support for Windows XP and Windows Vista.

For Windows XP, use driver version 10.85.0.0 or newer.

For Windows Vista, use driver version 10.100.0.0 or newer.
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Manageability Feature Enabling

Manageability features such as DASH and ASF are disabled by default on the Broadcom NetXtreme
Gigabit Ethernet Plus network adapter.

DASH Enabling

DASH can be enabled in one of two methods:
* Broadcom Manageability Configuration and Control application (BMCC)

®  Broadcom Advanced Control Suite (BACS)

BMCC is not pre-installed in the system image. It requires the Broadcom NetXtreme Gigabit Drivers for
Multiple Operating Systems Softpaq to be downloaded. BACS is included in the system image.

The following steps will enable DASH with BMCC:

1. Download the Broadcom NetXtreme Gigabit Drivers for Multiple Operating Systems Softpaq from
www.hp.com.

Install the Softpag.
Open a Command box as Administrator.

Go to the directory where the Broadcom application is installed.

vk LN

Run bmce enable.

The following steps will enable DASH with BACS:

1. Execute BACs.

2. Choose the Broadcom NetXireme Gigabit Ethernet Plus network adapter.

Note that all network adapters will be displayed by BACS. The Broadcom NetXireme Gigabit Ethernet
Plus can be identified through the Information tab. Look for the ASIC and Firmware of 5761.

Q]

invent


www.hp.com

Figure 6 Broadcom NetXtreme Gigabit Ethernet Plus network adapter - Information tab
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3. Go to the Configuration tab.

| Management Firmware

Wy DASH 1.01.0.12 ¢

4. Expand the OOB Management list to determine if DASH is enabled or disabled. By default DASH

is disabled.
Figure 7 OOB Management list
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Figure 8 Enabling DASH
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ASF Enabling

ASF can be enabled with the Broadcom Advanced Control Suite (BACS). Steps 1 - 5 are the same as
enabling DASH, but there are a few additional steps.

1 - 5) Same as enabling DASH (see above).

6) Set Management Console Address.

7) Set SNMP Connectivity Name.

In addition, make sure the Secure RMCP Support for ASF 2.0 is enabled.

Setting Up Initial Administrator Account for DASH

Setting up an Administrator account for DASH requires the use of the Broadcom NetXtreme Gigabit Driv-
ers for Multiple Operating Systems Softpaq. This is available at www.hp.com.

Execute the Softpag, and then open a Command box as Administrator.
Use the following steps to create an Administrator account:
1. Go to the directory where the Broadcom application is installed.

2. Runbmcc edit. This will execute the Broadcom Manageability Configuration and Control applica-
tion and will bring up a list of Management Firmware Configuration options.
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Figure 9 Management Firmware Configuration options
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3. Enter U for User Account Management.
4. Enter 2 for User Accounts.
5. Enter 1 for Administrator Account.

Figure 10 Management options
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s
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6. Enter 2 to change Offline from True to False.
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7. Enter 4=xxx where xxx is the password to set a password. The password by default is blank.

Figure 11 Management options
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8. Enter O twice to get back to the main page.
9. Enter Q to Save and Exit.

Figure 12 Save and exit
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After saving to NVRAM and exiting, the Administrator account along with the password has been cre-
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WebGUI

The WebGUI is a web browser based interface for limited remote system management.

The WebGUI is will only function once the Administrator account has been enabled and a password is
set with bmcc.exe.

The WebGUI is accessible from the following web browsers:
®  Microsoft Internet Explorer 6 SP1 or newer

®  Netscape Navigator 7.1 or newer

*  Mozilla Firefox 1.0 or newer

*  Mozilla 1.7 or newer

Limited remote system management includes:

* Hardware inventory for processor and memory

* Remote system power on, power off, or reset

* Determining network settings

® Sefting up users accounts

Connecting with the WebGUI:

1. Execute a web browser from a separate system - a management system that is also on the same sub-
net as the DASH system.

2. Connect to the IP address and port of the DASH system.
By default the port is 623.
Example A: hitp://172.16.2.17:623

3. The management system makes a TCP connection to the DASH system and accesses the top level
embedded web page.
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Figure 13 Logon screen
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The server 172.16.2,17 at Broadcom Management Service
requires a username and passward.

User name; Iﬁ | j

Password: I

[~ Remember my password

0] 4 Zancel

4. Enter user name and password. The default user name is "Administrator" or "Operator" depending
which account was set with bmcc. The password is blank by default, but can be changed during
DASH account setup with bmec.
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